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Chapter 1: Introduction

I.  ABOUT CARDMAKER

Thank you for choosing CardMaker for Windows.  This easy
to use software application is designed specifically for use
with FARGOÕs complete line of photo ID card printers.
CardMaker provides a full range of card design and database
features which allow you to design, store, and print ID card
formats simply and efficiently.

To begin creating and storing your own custom photo ID
cards, please refer to the remainder of this manual.   The
CardMaker UserÕs Manual is your complete guide to
installing and operating CardMaker for Windows.

II.  SYSTEM REQUIREMENTS

¥ Microsoft Windows 3.1 (or higher)

¥ Microsoft Compatible Mouse

¥ 486 CPU recommended

¥ 8MB RAM recommended

¥ Hard Disk with at least 10 MB available (saved images
require approximately 30K each)

¥ Video Associates LabsÕ Video Vue image capture board /
Sony Hi-8 Handycam or Hi-8 compatible video camera
(Hi8, S-Video Output, 400 line horizontal resolution,
710,000 pixels)

-or-

TWAIN Compatible Device and Interface Software

¥ SVGA Card with 1MB RAM or higher (custom setup
required: 800 x 600 x 65K colors )

NOTE: The Video Vue product from Video Associates Labs (512-346-5781)
is the only non-TWAIN capture board supported.  CardMaker is
preconfigured to automatically operate with this board.

1-2 Introduction
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III.  PRODUCT CHECKLIST

Upon opening the CardMaker package, make sure that all
necessary items are included.  The following items should be
included within the CardMaker packaging:

¥ CardMaker Diskettes (two 3.5Ó disks)

¥ Sentinel Pro

¥ CardMaker UserÕs Manual

¥ Registration Card

IV.  REGISTRATION

Please return the product registration card found in your
CardMaker packaging. 

As a registered CardMaker user, you will be entitled to
FARGO Technical Support and will also be informed of any
product updates or new product releases.  Mail or Fax your
registration card today!

V.  WINDOWS BASICS

To operate CardMaker, you must already be familiar with
Windows and its basic functions.  For example, you should
know how to move around within Program Groups, how to
use a mouse, and so on.  If you are not yet familiar with
Windows, consult the appropriate Microsoft documentation
to become familiar with the basics of Windows before
proceeding.

VI.  TECHNICAL SUPPORT

If you have questions about CardMaker which cannot be
solved through this manual, call FARGOÕs Technical Support
Group at (612) 941-8826.  Customer and technical support
representatives are available Monday through Friday, 7:30 AM
to 5:30 PM Central Standard Time.  You may also leave a
message 24-hours a day if youÕd like to have a representative
call you back the next business day.  To FAX a question, the
Tech Support FAX number is (612) 941-1852.  To reach FARGO
on-line, contact FARGOÕs BBS at (612) 942-7958 or contact
FARGOÕs WWW Home Page at http://www.fargo.com.

Introduction  1-3
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Chapter 2: System Installation 
and Assembly

This chapter explains how to install and configure all
necessary hardware and software components including
CardMaker, the Video Vue image capture board, and
CardMakerÕs Sentinel Pro.  If using a TWAIN device, sections
II and V of this chapter do not apply.  For specific
instructions on installing and operating your TWAIN device,
refer to the appropriate documentation included with that
device.

I.  VIDEO DRIVER SETUP
To run CardMaker, you must have an SVGA Card with 1MB
of RAM or higher installed in your system.  In addition, you
should have your display resolution set to 800 x 600 with
65,000 colors.  If your video card is not configurable to these
specifications and displays only at a 640 x 480 display
resolution, the entire CardMaker screen will not display
when CardMaker is running.  You will find that the Data
Entry window, which should display along the right-hand
side of the screen, is only partially visible.  With the proper
display setup, the CardMaker screen should appear as
shown in Chapter 3, section I.

To verify the proper configuration of your display, select the
Windows Setup icon from the Main program group.  The
Display: setting should be set to 800 x 600 x 65K colors.  If
the Display: setting is not set to this specification, refer to
your specific video cardÕs documentation or to the
appropriate Windows documentation to properly configure
your systemÕs display.  If your video card is not configurable
to the above specifications, obtain a compatible video card
and install it according to its supplied documentation.

NOTE: If you have your display resolution set to 800 x 600 and you still
find that part of your CardMaker screen is being clipped, be aware
that some video cards still display at a resolution of 640 x 480 even
when set to 800 x 600.  Contact the video card manufacturer if you
experience this type of difficulty.

2-2 System Installation and Assembly
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II.  VIDEO CAPTURE INSTALLATION

To run CardMaker with the Video Vue image capture board
you must install the Video Vue board exactly as described in
this section.  The Image Controls within CardMaker are
configured to automatically communicate with the Video
Vue board once it is installed.  If using a TWAIN device, this
section does not apply.  Refer to the following steps to install
and configure the Video Vue image capture board:

1. The Video Vue card is preset at the factory for base I/O
address 2E0 hex.  If this conflicts with other hardware in
your computer, select one of the three different hardware
I/O addresses through jumper JU101.  The location of
JU101 is shown in this illustration.

The I/O address blocks available with Video Vue are
(hexadecimal) 280, 2A0, and 2E0.  The factory default
setting is 280.  The following illustration shows the
jumper settings used to select the I/O address.

280

I/O
Address

2E0

2A0

A      B

A      B

A      B

JU101
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2-4 System Installation and Assembly

NOTE: Address 2E0 is selected by removing the jumper altogether.
Alternatively, it may be stored on the center post at a right angle so
it does not make an electrical connection with other posts.

2. Disconnect your computerÕs power and remove its cover.
Be sure to consult the appropriate computer
documentation before completing this step.

3. Install the Video Vue card in any 8 or 16-bit slot.  A 16-bit
slot will provide better performance.

You do not need to install the software which is provided
with the Video Vue capture board.  This software is already
included on the CardMaker disks and will automatically
install and open with CardMaker.

III.  SOFTWARE PROTECTION

Locate the Rainbow Technologies Sentinel Pro which shipped
in the envelope containing the software disks and this
manual.  The Sentinel Pro is a software protection device
used to prevent unauthorized duplication of the CardMaker
program.  CardMaker will not function without it.  

To install the Sentinel Pro, turn off your computer.  Installing
the Sentinel Pro with your computer powered on, could
damage the sentinel.  Connect the Sentinel Pro to the parallel
port of your computer and tighten the locking screws.  Once
the Sentinel is securely attached, connect your printerÕs
parallel cable to the back of the Sentinel Pro.  Installation of
the Sentinel Pro is now complete.  

IV.  INSTALLING CARDMAKER

Before installing CardMaker, make sure that the Color ID
Card Printer driver is already installed and selected as your
default printer.  If the driver is not installed, install and
configure it according to the instructions in Section 6 of the
Color ID Card Printer OperatorÕs Manual.  
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In addition, you should also make sure that your systemÕs
Autoexec.bat file is configured properly before installing
CardMaker.  Your Autoexec.bat file must be set up with the
Share.exe and the SET TEMP= command lines in order to
run CardMaker.  To enter these command lines into your
Autoexec.bat file, refer to the following steps:

1. Exit Windows

2. Create a directory called ÒTEMPÓ in your root directory
by typing md temp at the c: prompt.  It is in this
directory that all temp files will be stored.

3. Type edit autoexec.bat at the c: prompt and press the
Enter key.  The Autoexec.bat screen will then appear.

4. Using your arrow keys, move the cursor down toward
the bottom of the list of file entries.

5. Near the bottom of the list, enter the command line:  
SET TEMP=c:\temp Ñ this tells your system to place all
temp files into the TEMP directory you just created.

6. On the next line down, type the command line:
Share.exe/L:500 Ñ this command installs the file sharing
and locking capabilities needed by CardMaker.

7. Once the command lines have been entered, press and
hold the Alt key followed by the F key.  This will display
the File menu options.  Press the S key to save the
changes.  Press the above Alt F key sequence again, then
press the X key to exit the Autoexec.bat screen.

8. Reboot your system to activate the system changes you
just made.

Once your system is configured as indicated in the above
steps, you can then install CardMaker.  Refer to the following
steps to install CardMaker:

1. Insert the CardMaker diskette into the 3.5Ó disk drive on
your computer.

2. Select the Run option from Program ManagerÕs File
menu.

3. Type the location of your disk drive followed by the
word SETUP into the Command Line box of the Run
screen and click on OK.  (For example, if you insert the
CardMaker diskette into your A drive, type A:\SETUP).
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2-6 System Installation and Assembly

4. The install program will then ask you where you would
like CardMaker to be installed.  Click the Continue
button to install CardMaker to the default directory.
CardMakerÕs setup program will prompt you when you
need to insert disk #2.

5. When the CardMaker install program finishes, you
should see an ÒInstallation SuccessfulÓ message on your
screen.  If any other messages appear before this
message, respond as directed and retry the SETUP
procedure.  Once installation is complete, you will find a
new program group called CardMaker in the Windows
Program Manager.  Within that program group you will
find the CardMaker icon.  To open CardMaker double
click on the CardMaker icon.  Before opening
CardMaker, however, be sure that the included Sentinel
Pro is installed according to the directions in section III
of this chapter.  Refer to the following chapters of this
manual for instructions on using CardMaker.

V.  SYSTEM ASSEMBLY

If using the Video Vue image capture board along with a Hi-
8 compatible video camera, this section will take you through
the procedures required to assemble your complete ID card
printing system.  If using a TWAIN device, this section does
not apply.

Refer to the following steps to assemble your system:

1. If your system is currently powered on, turn it off now.
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System Installation and Assembly  2-7

2. Connect the VGA monitor cable to the 15-pin MON
connector on Video Vue.

3. Use the supplied VGA pass-through cable to connect
your VGA card to the VGA connector on Video Vue.   

Video Vue
REAR PANEL

VGA Pass-Through
Connector

VGA Adapter
REAR PANEL

VGA Pass-Through
Cable

VIDEO

MON

VGA

VGA Monitor

15-Pin Mini
D-Sub Connector

VGA Monitor
Connector

Video Vue
REAR PANEL

VIDEO

MON

VGA

510460 Fargo  8/5/98 11:35 AM  Page 2-7



2-8 System Installation and Assembly

4. Connect the video camera to the VIDEO connector on
Video Vue with an S-video cable (this cable is not
supplied with the Video Vue card).  If you wish you may
power on your system at this time or wait until the rest
of the system is assembled.  

5. If you have not already done so, install the Sentinel Pro
according to the directions in section III.

6. Connect one end of the parallel cable to the back of the
Sentinel Pro and tighten the cableÕs locking screws.

Sentinel Pro

Parallel Cable

To Camera

4-Pin
MINI DIN
S-VIDEO
Connector

VIDEO

MON

VGA

Video Input
Connector

Video Vue
REAR PANEL
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7. Connect the other end of the cable to the printer.  Snap
the fastening clips into place.

System assembly is now complete.  If you have not already
done so, power on your computer and the printer.  Once
Windows has loaded, double click on the CardMaker icon
within the CardMaker program group to start the program.
Refer to the remainder of this manual for instructions on
using CardMaker.
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Chapter 3: The Data Entry Mode

3-2 The Data Entry Mode

CardMaker has two separate ÒmodesÓ of operation:  the Data
Entry mode and the Card Design mode.  The Data Entry
mode is readily displayed and completely functional as soon
as CardMaker is opened.  In this mode, you have control
over all aspects of CardMakerÕs data entry capabilities such
as opening existing card formats, capturing photos, entering
and saving database information, and printing.  The only
capability you are denied in the Data Entry mode is the
ability to design your own custom card formats.  This can
only be done in the Card Design mode.  See Chapter 4 for
more information on the Card Design mode. 

This chapter defines the basic function of all menu selections
and on-screen features available in the Data Entry mode.  

I.  THE DATA ENTRY SCREEN
The Data Entry screen, pictured below, is active as soon as soon
as CardMaker is started.  This screen displays a default ID card
outline and all selectable features.  Please note that the size and
orientation of the default ID card outline are controlled by the
options within the Printer Setup window of the Color ID Card
Printer driver.  Refer to the following sections for information
about all features of the Data Entry Screen.
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II.  DATA ENTRY SCREEN MENU SELECTIONS

A. The File Menu

Open Format
Opens and displays an existing card format which serves as a
type of on-screen template for ID photos and other variable
data being entered into the database.  Be sure to have the
Color ID Card Printer driver installed and selected before
opening an existing card format. To open a file:

1. Select Open Format.  The Open dialog box appears.

2. Specify the drive, directory, and file name of the file you
wish to open.

3. Select the file and click on the OK button or double click
on the file name.  This will open the file you have
chosen.  When the file opens, you may notice that the
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3-4 The Data Entry Mode

layout, size, and/or orientation of the existing card format
may not match that of the on-screen default ID card
outline.  This outline must surround your card design
since it serves to define the printable area of an ID card.

To adjust this outline according to your existing card
format, select the Printer Setup option from the File menu
to adjust the outlineÕs size and orientation.  To adjust the
outlineÕs layout (i.e. Two Sided Card, Two Sided Mag
Stripe, etc.), choose the Card Layout option from the File
menu.

Card Layout
Allows you to select the appropriate card layout for your new
or existing card design.  Be sure to have the Color ID Card
Printer driver installed and selected before selecting a card
layout. Please note that two sided card formats can only be
selected when printing with FARGO ID Card Printers that
support dual-sided printing. To choose a layout:

1. Select Card Layout.  The Choose Format dialog box
appears.

2. The following Card Formats are available:  One Sided
Card, Two Sided Card (for printing onto both sides of a
card), Two Sided Mag Stripe (for printing onto both sides
of a card which has a magnetic stripe on the back),
Portrait/Landscape (for printing a  two sided card with a
portrait front and a landscape back), and Portrait/
Landscape Mag Stripe (for printing a two sided card
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The Data Entry Mode  3-5

with a portrait front and a landscape back with mag
stripe).  Once you select a Card Format, select the Printer
Setup option from the File menu to adjust the size and
orientation of the card layout.  Please note that the
Portrait/Landscape and Portrait/Landscape Mag Stripe
layout options cannot be selected when the Color ID
Card Printer driver is set to Landscape orientation.

3. Select the card layout option thatÕs appropriate for your
existing card format (or for a new card format when in
the Card Design mode).

Database Open
This option allows you to individually open and manipulate
multiple databases within CardMaker.  When installed,
CardMaker automatically creates two database files which
have a .mdb extension.  The one named cardbase.mdb is the
default database which will be used unless you create and
specify another.  The one named template.mdb is for use
when creating a new database.  To open an existing database:

1. Select Database Open.  The Open dialog box appears.

2. Specify the drive, directory, and file name of the database
you wish to open.

3. Select the database and click on the OK button or double
click on the database name to open the specific database.

To create a new database, create a new directory and copy
(do not move) the template.mdb file from the CardMaker
directory to that directory.  Once the template.mdb file is
copied, rename it according to what you would like to call
your new database.  You must do this for each new database
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you create, since two database .mdb files cannot exist in the
same directory.  The new database can then be opened as
described in the previous steps. Upon closing, CardMaker
will remember which database you were using and will re-
open that database next time CardMaker is started.

Current Database
This option presents a dialog box which shows you the name
and location of the database in which you are currently
working.

Export As TXT File
Allows you to export your entire database to a single TXT
file.  This feature is useful when transferring database
information from one database to another.  To export your
CardMaker database:

1. Select Export As TXT File. The Save As dialog box
displays.

2. Specify the drive and directory to which you intend to
save the exported TXT file.

3. Enter up to an eight character file name descriptive of
your exported database into the File Name: box of the
Save As window.  Click on the OK button or press the
enter key to export the data.  CardMaker always exports
database information in a Ò.txtÓ file format.  This file
format allows you to open and/or edit the text file in any
text editing program such as Microsoft Notepad which is
located in the Accessories program group of Program
Manager.  

3-6 The Data Entry Mode
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Upon opening an exported TXT file, you will notice that each
individual database record is placed on a separate line.
Likewise, each individual data field within each database
record is separated by a comma (Example:  Bill
Smith,Corporate,12345).  If you already have commas within
the actual database record (Example:  Smith, Bill), such
commas will also appear among those commas added during
the export.  To distinguish the commas you would like to
actually display once the data field information is imported
back into a database, please see the following Import TXT
File description.

NOTE: The data contained within the CardID field and any image or photo
associated with a database record will not be exported and will not
appear along with the rest of the database information.  CardMaker
will automatically add a numerical entry into the CardID field
when importing database information.

Import TXT File
Allows you to import other database records into
CardMaker.  This feature is useful when combining several
outside databases into CardMakerÕs single database.  To
import data:

1. Select Import TXT File.  The Open dialog box displays.

2. Specify the drive, directory, and file name of the TXT file
you wish to import.

3. Select the file and click on the OK button or double click
on the file name.  This will import the file you have
chosen.  Imported database information will
automatically be added to the end of the database and
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3-8 The Data Entry Mode

will be assigned a sequential number within the CardID
field.  CardID field names beginning with a letter will
always appear first in the database and will be listed in
alphabetical order.  CardID field names beginning with a
number will always appear second and will be listed in
an ascending numerical order.

When importing data, remember that each individual
database record within the imported TXT file must be
placed on a separate line.  In addition, each individual
data field within each database record must be separated
by a comma (Example:  Bill Smith,Corporate,12345).  If,
however, you wish to use a comma within a single data
field as part of the actual data field information, replace
the commas separating each field with double quotes.
When listed properly, each data field within the line of
database record information will be surrounded by
double quotes (Example: “Smith, Bill””Corporate””12345”).
This will force a data field separation when the
information is imported into CardMakerÕs database.

Select TWAIN Source
TWAIN was developed by a coalition of industry leaders to
define a standard software protocol for communication
between a software application (such as CardMaker) and
devices that acquire images (such as scanners, digital
cameras, etc.).

The Select TWAIN Source option allows you to select your
specific TWAIN device through which you intend to capture
or acquire images.  This option is not applicable if using the
Video Vue image capture board since it is not a TWAIN
compatible device.  To choose your TWAIN device:

1. Choose Select TWAIN Source.  The Select Source dialog
box displays (this box will not display if you do not have
a TWAIN device driver installed on your system).

510460 Fargo  8/5/98 11:35 AM  Page 3-8



The Data Entry Mode  3-9

2. Select the device and click on the Select button or double
click on the device name.  This will connect CardMaker
to the specific TWAIN device installed on your system.
Once connected, simply click on the TWAIN button
within the Image Control box to open your specific
TWAIN device image capture software (refer to section
VII for further Image Control box information).  Images
captured through your TWAIN device will load into the
first picture box created and can be manipulated through
the Image Controls.  

Print
Allows you to print your card format once you have entered
all appropriate data.  To print:

1. Select Print.  The Print dialog box displays.
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3-10 The Data Entry Mode

2. Select the Setup... button to check that the proper printer
and printer driver options are selected.  The Print Setup
dialog box displays.

3. Be sure that the Color ID Card Printer is selected as your
current printer, and select the appropriate printer driver
options (refer to the Color ID Card Printer OperatorÕs
Manual for further printer driver information).  Select the
Options... button to display and select additional printer
driver setup options.  When the driver is set
appropriately, select OK from the Print dialog box to
print your image.

Printer Setup
Allows you to select the appropriate printer and printer
driver options (see Print option or refer to the ID Card
Printer OperatorÕs Manual).

Print Batch
Allows you to print a specific range of database records
formatted to the specifications of the on-screen card format.
To initiate a batch print:

1. Select Print Batch.  The Database Record Selection dialog
box displays.
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2. Select the Data Field from which you will be specifying
the range of database records to be printed.  Example:  If
you wish to print a range of last names you have entered into
Data Field 1, select Data Field 1 from the list of Data Fields.

3. Enter any letter, number or series of each into the From:
and To: boxes and select the OK button.  This will
specify the range of database entries you wish to print.
Example:  If you wish to print a range of last names entered
into Data Field 1, type Benson into the From: box and Smith
into the To: box.  CardMaker will then print all records with
last names ranging from Benson to Smith.

4. Select the Search Numeric option if you would like to
specify a range only by its numerical value.  If the Search
Numeric option is not selected, records are sorted by
their alpha numerical value.  Sorting alpha numerically
can be a problem if you would like to sort a range of
entries only by their specific numerical order.  Example:  If
you wish to specify a range of records from 1 to 5, and the
Search Numeric option is not selected, the search will find
records 1, 11, 2, 22, etc.  With the Search Numeric option
selected, the search will find only records 1, 2, 3, 4, and 5.

The default entry within the From: and To: boxes is an
asterisk (*).  This asterisk serves as a wildcard character
which represents a whole word or group of characters.  The
wildcard character is very useful in specifying a general
range of database entries.  Example:  If you wish to print the
entire database, leave the asterisk (*) character in both the From:
and To: boxes.  If you wish to print a range of entries beginning
with the last name Smith and ending with the last entry in the
database, type Smith into the From: box and the (*) character into
the To: box.

Rotate
Allows you to select the angle at which you would like the
captured photo to be presented.  Select 270 Rotate, 180
Rotate, 90 Rotate, or 0 Rotate accordingly.

Unlock Design Access
This option unlocks the Card Design screen, allowing you to
design your own card formats.  When in the Data Entry
mode, the Card Design screen and all card design options are
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hidden.  This feature not only denies card design access to
unauthorized personnel but, most importantly, safeguards
against your accidentally altering a card format.  To activate
the Card Design screen:

1. Select Unlock Design Access. The Enter Password
dialog box displays.

2. Enter the code 3127 into the password dialog box and
click on the OK button or press the Enter key.  The Card
Design screen will then appear (see Chapter 4 for
information on the Card Design screen).  This password
is fixed and cannot be changed or customized.

Exit
Exits CardMaker and returns you to the Windows Program
Manager. 

B. The Edit Menu

Insert Image
Inserts an image into the picture box area of the on-screen
card format.  When in the Data Entry mode, images are
always inserted into the card formatÕs primary or first picture
box.  When in the Card Design mode, images are always
inserted into the selected picture box.  

This option is useful if you wish to insert a saved image from
another disk or application program into your card format.
Example:  If you have pre-saved a number of ID photos onto a disk
at another location, the Insert Image option allows you to pull those
photos off of that disk and to save and print them in your current
ID card format.
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To insert an image:

1. Select Insert Image. The Open dialog box displays.

2. From the List Files of Type box, select the file format of
the type of file you intend to insert.  CardMaker accepts
the following file formats:  BMP, DIB, GIF, JPEG (*.jpg),
PCX, TIFF (*.tif), TARGA (*.tga), WMF.

3. Specify the drive, directory, and file name of the file you
wish to insert.

4. Select the file and click on the OK button or double click
on the file name.  This will insert the file you have
chosen into the on-screen picture box of your card
format.  Please note that the original images inserted into
these picture boxes must be saved somewhere on your
system, otherwise they will not be found when that
particular format is re-opened.

C. The Help Menu

Allows you to search for and access helpful information on
CardMaker features and options.

III.  DATA ENTRY SCREEN TOOL BAR ICONS

The Tool Bar Icons are located at the top of the screen just
below the menu selections.  Refer to the following for a
description of each icon. 
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3-14 The Data Entry Mode

Click on this icon to open an existing card format.
This icon duplicates the same function as the
Open Format option of the File menu.

Click on this icon to begin printing immediately
with the current printer driver settings.  Be sure
you have the appropriate printer and printer
driver setup options selected before clicking on
this icon.  The Print Setup dialog box cannot be
accessed through this option.  Refer to section II-A
for further printing information.

IV.  DATA ENTRY FIELDS

The Data Entry Window displays all
of the data fields in which database
information can be entered and
stored.  It is through these fields that
all database information must be
entered.  If you want the information
being entered into the database to
also appear on your card format
when printed, the data field
containing the data must already be
linked to a specific text field on your
card format.  Linking a text field to a
data entry field can only be done
through the  Card Design screen (see
Chapter 4, section II-D for more
information on linking text fields to
the database).

The Data Entry Window is
comprised of three basic types of
data fields, all of which can be linked

to a card format.  The first is the CardID: field or the top
most field in the Data Entry Window.  This field can contain
up to eight characters and serves to distinguish, or name,
each individual database record before it is saved.  The entry
within this field also serves to name the captured or inserted
JPEG image associated with each particular record.  Once
saved, the full name and location of the JPEG image will
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display in the Status Display Box located just beneath the
Data Entry window.

The CardID: field must always contain some sort of a unique
entry, such as a personÕs identification number, employee
number, or even just a sequential ID entry number, in order
to distinguish that particular record from all others.  If you
wish to have a sequential number automatically placed into
this field, simply click on the Auto ID: check box in the
upper left-hand corner of the Data Entry Window.  This
feature will automatically place a new sequential number
into the CardID: field as each new database record is created.
By making at least one field in the database entirely unique,
CardMaker makes it impossible for you to accidentally save
a duplicate record to your database.  CardMaker will not
allow you to save a new record without entering a unique set
of characters into the CardID: field.

The second type of data field is represented in Fields 1-20.
These data fields can be used for all general database
information such as a personÕs name, social security number,
ID number, date of birth, etc., and can contain up to 255
characters per field.  In addition to being able to enter any
variable database information into these fields, you can also
rename these fields through the Card Design screen in order
to customize your Data Entry Window (see Chapter 4,
section II-D for more information on renaming these fields).

The third type of data field is represented in Fields T1-T3.
These data fields should only be utilized if using CardMaker
in conjunction with a Color ID Card Printer containing either
a high or a low coercivity magnetic stripe encoding module.
If your printer has a magnetic stripe encoding module,
simply enter the data you would like encoded on track 1 of
the magnetic stripe into the T1 field.  Do the same for tracks
2 and 3 in the T2 and T3 fields.  All magnetic track data
should be entered according to the information given in
Appendix A (or B) of the Color ID Card Printer OperatorÕs
Manual.  By selecting the Auto Sentinels check boxes located
just to the left of the T1-T3 data fields, you enable CardMaker
to automatically insert the Start and End sentinels into the
string of magnetic track data.  These sentinels must be
present in all magnetic track data in order for it to be
properly encoded onto a cardÕs magnetic stripe.  
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V.  DATA CONTROL BOX

The Data Control box features all necessary controls for
navigating through and controlling the CardMaker database.
Each data control feature is described below.

Navigation Bar
The Navigation Bar allows you to easily navigate between
records within the database.  By clicking on the outer arrows
you can quickly move to either the first or last record of the
database.  By clicking on the inner arrows, you can move
forward or backward within the database, one record at a
time.  The display box between the arrows always lets you
know exactly which database record is being displayed.

New
Creates a new database record.  Select this option when you
wish to add a new ID entry to your existing database.
Remember that a unique name must be entered in the
CardID field before the new entry can be saved.  The display
window within the Navigation Bar will automatically update
as each new record is added.  To compile new entries with
existing records select the Update database button (see last
part of this section for more information on the Update
database function).

Save
Saves all database record information along with the inserted
or captured image to the existing database.  
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IMPORTANT: It is important to remember that inserted or
captured images are saved separately from the rest of the
database information in a compressed JPEG file format.  The
JPEG format is a special file format which shrinks or
compresses the size of an image file so that it takes up less
space on your hard disk when saved.  The only drawback to
this file format, however, is that the overall image quality
tends to slightly degrade each time the image is resaved.
This is due to the file having to be compressed and
recompressed every time the file is saved.  After five or six
saves and recompressions, this file degradation will become
apparent on the printed card.  Because of this, CardMaker
provides two different means of saving a database record.  

The first is activated by selecting the Save button.  Selecting
this button not only saves the record information, but also
compresses and saves the ID image in a JPEG file format.
Select the SAVE button after you have created a new
database record with a newly captured or inserted image.
Do not select the SAVE button every time a change is made
to the record information. Since the Save button saves both
the image and the record information, you do not need to
select the Save button again unless you recapture or reinsert
a new image.  If you simply change the record information,
the second means of saving a database record will apply.

The second means of saving a database record is activated
automatically each time you move to or create another
database record.  This automatic saving feature will save and
resave only the record information, not the image.  Through
this feature, you are always sure to save any changed record
information without unnecessarily resaving and degrading
the recordÕs unchanged image.

Also, remember to always enter a unique entry into the
CardID: data field before saving the new database record.

Delete
Deletes the current on-screen database record and image.

Find
This option allows you to locate specific database records.  To
find specific records:
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1. Select the Find button.  The Database Record Selection
dialog box displays.

2. Select the Data Field from which you will be specifying
the database record(s) to be located.  Example:  If you wish
to locate a range of last names you have entered into Data
Field 1, select Data Field 1 from the list of Data Fields.

3. Enter any letter, number, or series of each into the From:
and To: boxes and select the OK button.  This will
specify the range of database entries you wish to locate.
Example:  If you wish to locate a range of last names entered
into Data Field 1, type Benson into the From: box and Smith
into the To: box.  CardMaker will then find all records with
last names ranging from Benson to Smith. If you wish to
find one particular record, type the same entry into both
the From: and To: boxes.

Note that the display box within the Navigation Bar
displays the number of records found in the search.

4. Select the Search Numeric option to specify a range only
by its numerical value.  If the Search Numeric option is
not select, records are sorted by their alpha numerical
value.  Sorting alpha numerically can be a problem if you
would like to sort a range of entries only by their specific
numerical order.  Example:  If you wish to specify a range of
records from 1 to 5, and the Search Numeric option is not
selected, the search will find records 1, 11, 2, 22, etc.  With the
Search Numeric option selected, the search will find only
records 1, 2, 3, 4, and 5.
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5. To return access to the entire database, reselect the Find
button.  When the Database Record dialog box displays,
leave the asterisk (*) character in both the From: and To:
boxes and select the OK button.  All database records
will, once again, be available. The asterisk serves as a
wildcard character which represents a whole word or
group of characters and is very useful in specifying a
general range of database entries.

Display DB Image
Select this check box if you wish to display each database
recordÕs captured ID photo as you move from record to
record.  Be aware, however, that it will take longer for each
record to appear on screen with this option selected.  If you
wish to move quickly from one record to the next without
viewing each individual photo, do not select this option.

Update Database
Compiles all new and existing database records according to
the names entered within the CardID field.  CardID field
names beginning with a letter will always appear first in the
database and will be listed in alphabetical order.  CardID
field names beginning with a number will always appear
second and will be listed in an ascending numerical order.
Once compiling is finished, the database will automatically
return to record one.

VI.  VIDEO DISPLAY WINDOW

This section only applies if using the Video Vue image
capture board.  If using a TWAIN device refer to your device
documentation for information in its specific software
interface.
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When CardMaker is initially opened, the Video Vue image
capture software is also opened automatically once the Video
Vue board is detected.  This software displays as a small
window labeled ÒVideoÓ within the CardMaker screen.  The
Video display window serves as a type of on-screen eye-
piece to the video camera you have connected to your system
and will sit on top of the active window as long as the Video
Vue software is running.  To hide the Video display window,
select the Hide button from the Image Control box.

Through the Video display window, you will see a live
version of whatever is in front of the camera.  Use the Video
display window to locate and position the subject of your
image capture.  Use the Image Controls described in section
VII to capture and manipulate the image within its picture
box.  To close the Video display window, double click on the
minus sign in the upper left-hand corner or select the Hide
button to hide it.  To move the window, click and drag on its
title bar.

IMPORTANT: Upon opening CardMaker and the Video
Vue software, you should verify that the proper video
display settings are selected.  Such display settings include
display color, size, and input, as well as the position of the
live video image within the Video display window.  Refer to
the following steps to center the live video image within the
Video display window and to verify the appropriate display
settings:

1. Select the Video display window by clicking on its title
bar.  The title bar will highlight when it is selected.

2. While holding down the Alt key, press the B key.  A set
of Tool Bar Icons will appear on the right-hand side of
the Video display window.

510460 Fargo  8/5/98 11:35 AM  Page 3-20



The Data Entry Mode  3-21

3. Select the Adjust icon (third icon from the top).  The
Adjust menu selections will appear on the left-hand side
of the Video display window.  Click and drag on the
Adjust menuÕs title bar to move the menu.

4. Click on the Size button and select the 800 x 600 Capture
Size setting if not already selected.  Click on the OK
button to close the Size window.

5. Click on the Color button and select the Full Color (24-
bit) Color Depth setting if not already selected.  Click on
the OK button to close the Color window.

6. Click on the Input button and select the Single
Field/Motion Video Capture Type setting if not already
selected.  Click on the OK button to close the Input
window.

7. Occasionally, you may find that the on-screen, live video
image is not centered within the Video display window
when you open CardMaker for the first time.  This is
often caused by variations between VGA cards and VGA
modes.  If you are experiencing such a problem, you
should adjust the live video image to fit within the Video
display window by clicking on any of the four arrow
icons near the bottom of the Adjust menu.  If you choose
not to adjust the live video image to fit within in the
Video display window, you may experience general
protection faults within the CardMaker application
which could cause the application to quit or Òcrash.Ó   

8. Once all selections and adjustments are made, click on
the Done button to close the Adjust menu selections.
Click on the bottom Arrow icon of the Video display
windowÕs Tool Bar to close the selection of tool bar icons.

These are the only Video display window settings you need
to select, verify, or adjust.  Once adjusted or selected, these
settings will remain final and should not require further
changes.  All other Video display window options should
remain at their default settings.  
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VII.  IMAGE CONTROL BOX

The Image Control box features all necessary controls needed
for capturing and manipulating images.   Each camera
control feature is described below.

Video
This option is only active if using the Video Vue image
capture board.  If you do not have this board installed, the
Video button will remain dim.  Selecting this option allows
you to capture the current image within the Video display
window.  To capture an image:

1. Position your subjectÕs image within the Video display
window.

2. Once everything is positioned properly within the Video
display window, select the Video button.  After a few
seconds, CardMaker will display the captured image
within the primary picture box of your on-screen card
format.  You must have a picture box within your card
design before you can capture an image (see Chapter 4,
section IV for further picture box information).  You may
capture your subjectÕs image as many times as you like if
you are not satisfied with the current capture.  Always
remember to select the Save button from the Data
Control box once you have captured an image and have
entered all other database information.  Use the
appropriate Image Control box features to manipulate
the captured image.

TWAIN
This option is only active if using a TWAIN device.  Before
selecting this option, you must select the Select TWAIN
Source option from the File menu to connect CardMaker to the
specific TWAIN device installed on your system.  The TWAIN
button will remain dim until your TWAIN device is connected.
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Once connected, select the TWAIN button to open your
specific TWAIN device image capture software.  For
instructions on using this software, refer to the
documentation which shipped with your TWAIN device.
Images captured through your TWAIN device will load into
the first picture box created.  Always remember to select the
Save button from the Data Control box once you have
captured an image and have entered all other database
information.  Use the appropriate Image Control box features
to manipulate the captured image.

Zoom
Click on the left and right arrows or click and drag on the
slideÕs adjustment box to zoom in and out on the captured
image.  Zoom from 20% to 200% of the actual image size.  Be
aware, however, that zooming over 100% of the actual image
size may reduce the image quality when printed.

Pan
This feature utilizes two slide controls to move the image
left-and-right or up-and-down within the picture box of the
on-screen card format. Click on the arrows or click and drag
on the slideÕs adjustment box to move the image.

Rotate
Select this button to rotate the image clock-wise in 90¡
increments within the picture box of the on-screen card
format.  This feature is useful when adapting captured
images to various card designs and orientations.

VIII.  STATUS DISPLAY BOXES

There are two Status Display Boxes located on the bottom of
the CardMaker screen.  The first is the longer, white box
located just beneath the Camera and Data Controls.  This
status box displays information about CardMakerÕs current
function, such as when you are capturing an image, saving a
database record, etc.

The second status box is the shorter, white box located just
beneath the Data Entry Window.  This box displays the name
and location of the captured or inserted image currently
displayed within the database record.    
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Chapter 4: The Card Design Mode

In addition to the Data Entry mode, CardMaker also provides
a Card Design mode which allows you to design and save
your own ID card formats.  The Card Design mode is
activated by selecting the Unlock Design Access option in the
File menu of the CardMaker window.  Once this option is
selected and the appropriate security password is entered, the
Card Design mode is enabled (see Chapter 3, section II-A for
password information).  You will find that several new menu
selections and design tools are available in this mode.  These
new features offer many of the same design capabilities found
in other common Windows application programs, yet are
uniquely tailored to color ID card manufacturing.

This chapter defines the basic function of all menu selections
and on-screen features available in the Card Design mode.  

I.  THE CARD DESIGN SCREEN
The Card Design screen, pictured below, is accessed by
selecting the Unlock Design Access option from the File
menu.  Once accessed, the Card Design screen displays all
selectable features.  Notice that all functions of the Data Entry
mode are still available when in the Card Design mode.  Refer
to the following sections for information about each feature.
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II.  CARD DESIGN SCREEN MENU SELECTIONS

A. The File Menu

New Format
Creates a new, blank card format on which you can create
your own original card design.  Be sure to have the Color ID
Card Printer driver installed and selected before creating a
new card format. To create a new format:

1. Select New Format. The Choose Format dialog box
appears.
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2. Select the Card Format you would like to use for your
new ID card design.  The following Card Formats are
available:  One Sided Card, Two Sided Card (for
printing onto both sides of a card), Two Sided Mag
Stripe (for printing onto both sides of a card which has a
magnetic stripe on the back), Portrait/Landscape (for
printing a  two sided card with a portrait front and a
landscape back), and Portrait/Landscape Mag Stripe (for
printing a two sided card with a portrait front and a
landscape back with mag stripe).  Please note that two
sided card formats can only be selected when printing
with FARGO ID Card Printers that support dual-sided
printing.

3. Once you have chosen the appropriate Card Format,
select the Printer Setup option from the File menu to
adjust the size and orientation of the card layout.  Please
note that the Portrait/Landscape and Portrait/Landscape
Mag Stripe layout options cannot be selected when the
Color ID Card Printer driver is set to Landscape
orientation.

Open Format
Opens and displays an existing card format.  Unlike a card
format opened in the Data Entry screen, however, card
formats opened in the Card Design screen can be modified.
See Chapter 3, section II-A for more information on this
option.

Card Layout
Allows you to select the appropriate card layout for your
new or existing card design. See Chapter 3, section II-A for
more information on this option.

Save Format
Saves a card design which can then be opened and utilized
from either the Card Design mode or the Data Entry mode.
To save a card format:

1. Select Save Format. If the card format has been
previously saved to a specific file name, CardMaker will
simply overwrite that file name.  If the card format is
completely new design and has not been saved to a
specific file name, the Save As dialog box displays.
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2. Specify the drive and directory to which you intend to
save the new card format.

3. Enter up to an eight character file name descriptive of
your new card format into the File Name: box of the Save
As window.  Click on the OK button or press the enter
key to save your new card format.  CardMaker always
saves new card formats into its own unique Ò.fmtÓ file
format.  This assures that CardMaker will always be able
to read and open your custom card designs.

Save Format As
Whether saving a previously saved card format or an entirely
new card format, selecting the Save Format As option will
always display the Save As dialog box.  When saving a new
card format, this option duplicates the function of the Save
Format option.  When saving a previously saved card format,
however, this option allows you to save that existing card
format under a different file name without overwriting the
original card format.    

Database Open
This option allows you to individually open and manipulate
multiple databases within CardMaker.  See Chapter 3, section
II-A for more information on this option.

Current Database
This option presents a dialog box which shows you the name
and location of the database in which you are currently
working.
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Export As TXT File
Allows you to export your entire database to a single TXT
file.  This feature is useful when transferring database
information from one database to another.  See Chapter 3,
section II-A for more information on this option.

Import TXT File
Allows you to import other database records into
CardMaker.  This feature is useful when combining several
outside databases into CardMakerÕs single database.  See
Chapter 3, section II-A for more information on this option.

Select TWAIN Source
Allows you to select your specific TWAIN device through
which you intend to capture or acquire images.  This option
is not applicable if using the Video Vue image capture board
since it is not a TWAIN compatible device.  See Chapter 3,
section II-A for more information on this option.

Print
Allows you to print your card format.  See Chapter 3, section
II-A for more information on this option.

Printer Setup
Allows you to select the appropriate printer and printer
driver options.  See Print option description in Chapter 3,
section II-A for further printer setup information.

Print Batch
Allows you to print a specific range of database records
formatted to the specifications of the on-screen card format.
To initiate a batch print, see Chapter 3, section II-A.

Rotate
Allows you to select the angle at which you would like the
captured photo to be presented.  Select 270 Rotate, 180
Rotate, 90 Rotate, or 0 Rotate accordingly.

Lock Design Access
When you have designed and saved a card format and you
wish to lock design access to that format, select this option.
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Once selected, you will immediately be returned to
CardMakerÕs Data Entry Screen.

Exit
Exits CardMaker and returns you to the Windows Program
Manager. 

B. The Edit Menu

Cut
Deletes or ÒcutsÓ a selected image or object from your card
design.  Your keyboardÕs Delete key serves this same
purpose.

Insert Image
Inserts an image into an active or selected picture box of the
on-screen card design.  This option is useful if you wish to
incorporate a logo, graphics file, image file, or any other type
of saved image from another disk or application program,
into your card design.  To insert an image, select the picture
box in which the image is to be inserted, and refer to the
Insert Image description in Chapter 3, section II-B.  For
information on creating picture boxes refer to section IV of
this chapter.

Text
This option allows you to enter or edit text within a selected
text box.  To edit text:

1. Create an on screen text box (see section IV to create a
text box).  If not already selected, click on the text box to
select it.  When selected, small black squares or
ÒhandlesÓ will appear around the text box.
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2. Select Text.  The Edit Text dialog box displays.

3. Enter the text you wish to display on your card design.
Once the text is entered, select the OK button or press
the Enter key to return to the card design screen.  The
text entered should now be shown on your card design.
Choose options from the Change menu described later in
this section to change the font or color of selected text.

Send To Back
CardMaker has the ability to automatically stack or layer
objects on top of each other within a card design.  With the
four different types of objects CardMaker allows you to place
in your card design, however, there is a preset order in which
those objects will appear when printed.  From BOTTOM to
TOP (or back to front), this order is as follows:  Rectangles,
Picture Boxes, Lines, Text.  In other words, if you design a
card containing all these objects, text will always print over
lines, which will always print over picture boxes, which will
always print over rectangles.  This order is preset according
to how most ID card formats are designed.

Due to this configuration, the Send To Back option is useful
for two main reasons.  The first is to visually arrange or layer
objects on-screen in order to aid in the design process.
Example:  If you place a large rectangle over an existing text box,
the rectangle will appear to cover the text on-screen even though
the text will always appear on top when printed.  Therefore, select
the rectangle and choose the Send To Back option to force the
rectangle to appear on the bottom layer.

The second is to arrange or layer two or more of the same
objects on-screen and also when printed.  Example:  If you
have a red rectangle and a blue rectangle and you would like the
red rectangle to appear and print beneath the blue rectangle, select
the red rectangle and choose the Send To Back option.  This will
force the red rectangle to appear beneath the blue rectangle both on-
screen and when printed.
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NOTE: When layering picture boxes, you will notice that they can be
layered on each other, but that they will always appear on top of all
other objects on-screen.  This can be awkward if trying to arrange
text and lines on top of a photo.  If, during the design process, you
would like to view those objects which will appear on top of a photo
when printed, select the appropriate picture box and choose the
Hide Selected Image option from the View menu.  Although this
will hide the image on-screen, it will still appear on your card when
printed.

C. The View Menu

Object Info
Displays information regarding the currently selected object.
To display object information, select an object and choose the
Object Info option.

Hide Selected Image
Removes a selected image from the design screen without
actually deleting it.  This option only applies to images
within picture boxes.  To display the image again, select the
UnHide All Images option.  Regardless of whether the
image is hidden or not, the image will always appear on a
card when printed.  Please note that the primary or first
picture box created cannot be hidden.

UnHide All Images
Select this option to display all images hidden through the
Hide Selected Image option.
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D. The Change Menu

Fonts
Select this option if you wish to change the font, font style,
size, or color of selected text.  This option can be selected
only if a text object is selected.  To change text:

1. Click on the text box to select it.  When selected, small
black squares or ÒhandlesÓ will appear around the text
box.  If you need to create an on-screen text box see
section IV.  

2. Select Fonts.  The  Font dialog box displays.  Choose the
appropriate font settings for your card design.

For best printing results, it is recommended that only
TrueType¨ fonts are used or selected.  If you wish to
incorporate bar codes into your ID card format and desire
them to be printed with the Color ID Card PrinterÕs resin
black ribbon panel, you must utilize a TrueType bar code
font.  Several TrueType bar code fonts are included with
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CardMaker.  Please refer to Appendix A for more information
on these included TrueType bar code fonts.

Link Data Field
This option links the selected text box to a specific data field
within the database.  CardMaker allows you to link a text
box to any of the data entry fields.  Once linked, any data
entered into the linked data field will automatically be
placed in the area of the card format containing the linked
text box.  It is this process which makes the variable data
entered into the data fields of the Data Entry screen appear
on a printed card format.  To link a text box to a data field:

1. Click on the text box to select it.  When selected, small
black squares or ÒhandlesÓ will appear around the text
box.  If you need to create an on-screen text box see
section IV.  

2. Select Link Data Field. The  Change DataField dialog
box displays.  

3. Click on the down arrow and select the data field you
wish to link to the selected text box.  Click on the OK
button to complete the link.  

NOTE: The names of the data fields shown in the Change DataField dialog
box will always remain as CardId, DataFld1, DataFld2, etc.,
regardless of what you may have changed them to through the
Change Data Field Name command.

Object Color
Changes the color of the selected object.  Select this option to
change the color of lines, text, picture box backgrounds, or
the outline of a rectangle.  To change an objectÕs color:
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1. Select the object you wish to change by clicking on it.
When an object is selected, small black rectangles or
ÒhandlesÓ will appear around the object.  To select a line,
click on either end.

2. Select Object Color. The Color dialog box displays.

3. Select a color from the Basic Colors group by clicking on
any of the color boxes.

4. Optionally, you may wish to define your own color by
clicking on the Define Custom Colors... button.
Selecting this button displays an additional area of the
Color dialog box.
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5. To define a custom color, click and drag on the black
cross-hairs within the large color box and on the white
arrow head to the right of the smaller color rectangle.
Numerical information can also be entered to more
accurately define a specific color value.  Once the desired
custom color is achieved, select the Add to Custom
Colors button to save your customized color to the
Custom Colors group.  If you wish to save a custom
color to a specific color box within the Custom Colors
group, select that box before you begin to define your
new customized color.

6. Once you have selected a color box from either the Basic
Colors group or the Custom Colors group, select the OK
button. 

Fill Color
This option changes the fill color of a selected rectangle.  To
change the fill color:

1. Select the rectangle you wish to fill by clicking on it.

2. Select Fill Color. The Color dialog box displays.  Refer
to the above description of the Object Color option for
information on using the Color dialog box.

Line Size
Select this option to vary the width of a selected line or
rectangle outline.  To change a selected line:

1. Select the line or rectangle you wish to change by
clicking on the center of a rectangle or on either end of a
line.

2. Select Line Size. The Change Line Size dialog box
displays.
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3. Click on the left and right arrows or click and drag on
the slideÕs adjustment box to increase or decrease the
width of the line.  The rectangle on the right-hand side of
the dialog box previews the line changes.

4. When you achieve the desired line thickness, select the
OK button.

Grid Setup
CardMaker, like most Windows drawing programs, gives
you the option of utilizing a drawing grid when designing a
card format.  A drawing grid is helpful for reference when
placing and aligning several objects onto a card.  To activate
CardMakerÕs drawing grid:

1. Select Grid Setup. The Grid Setup dialog box displays.

2. Enter or select the desired grid interval for the vertical
and horizontal grid setup.  The default grid setting is an
eighth of an inch (.125Ó).

3. If you wish to display the grid, select the Show Grid
check box.

4. If you wish to have an object automatically snap to the
nearest grid point when moved, select the Snap to Grid
check box.  This feature is helpful if you want to
accurately align several objects.

Data Field Name
Select this option if you wish to change the name of a specific
data field in order to customize your Data Entry window.  To
change the name of a data field:

1. Select Data Field Name. The Change Field Name dialog
box displays.
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2. Click on the down arrow of the Current box to display
and select any of the pre-named data fields.

3. Once you have selected the data field name you wish to
change, enter the new name into the New entry box and
click on the OK button.  Keep in mind that you are
limited by space within the Data Entry window as to the
number of characters your new data field name can
have.  If your new name contains too many characters, it
will be clipped when it appears in the Data Entry
window.

E. The Help Menu

Allows you to search for and access helpful information on
CardMaker features and options.

III.  CARD DESIGN SCREEN TOOL BAR ICONS

The Tool Bar Icons are located at the top of the screen just
below the menu selections.  Refer to the following for a
description of each icon. 

Click on this icon to open a new, blank card
format.  This icon duplicates the same function as
the New Format option of the File menu.

Click on this icon to open an existing card format.
This icon duplicates the same function as the
Open Format option of the File menu.

Click on this icon to save a card format.  This icon
duplicates the same function as the Save Format
option of the File menu.
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Click on this icon to begin printing immediately.
Be sure you have the appropriate printer and
printer driver setup options selected before
clicking on this icon.  The Print Setup dialog box
cannot be accessed through this option.  Refer to
Chapter 3, section II-A for further printing
information.

Click any of these icons to shift the alignment of
the text within the selected text box.  By clicking
on one of these three icons, you are able to shift
the text to the left, center, or right of the selected
text box.

IV.  CARD DESIGN SCREEN TOOL PALETTE

The Tool Palette is located along the left-hand side of the
Card Design screen.  From this palette, you can select any of
the tools needed to design a card format.  Refer to the
following for a description of each tool. 

Click on this icon to choose the Select tool.  The
Select tool allows you to select or deselect any of
the objects in your card design.  To select an object,
place the Select arrow on the selectable area of the
object and click the left mouse button.  When an
object is selected, small black boxes or ÒhandlesÓ
will appear around the object.  You can also use
the Select arrow to click and drag on a selected
object or on the objectÕs handles to move or resize
that object.  To deselect an object, simply click on
another area of the design portion of the screen.

Click on this icon to select the Line tool.  The Line
tool allows you to place up to 100 line objects into
your card design.  To create a line, click on the
Line tool to select it.  Then, click somewhere
within the card design area of the screen.  A
default line size will appear where you clicked.  

To move or resize the line, click and drag either of
the line handles to the desired location.
Remember that a line must be selected in order to
be modified.  When a line is first created, it is
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automatically selected.  If you wish to modify a
line which is not selected, you can select the line
by clicking on either end.  A line cannot be
selected by clicking on its middle.  To change the
color of a line, refer to the Object Color selection
within the Change menu.

Note: It is much easier to move and resize lines when the Snap
to Grid option within the Grid Setup dialog box is
selected (see Change menu selections in section II-D).

Click on this icon to select the Picture Box tool.
The Picture Box tool allows you to create up to
five picture boxes per card design.  Through these
picture boxes, you are able to insert photos,
company logos, or any other type of custom color
graphic.  To create a picture box, click on the
Picture Box tool to select it.  Then, click
somewhere within the card design area of the
screen.  A default-sized picture box will appear
where you clicked.

To move the picture box, click and drag on the
center of the box.  To resize the picture box, click
and drag on one of the handles.  To insert an
image into the picture box, choose the Insert
Image option of the Edit menu, or capture an
image by using the Image Control options on the
bottom left portion of the screen.  

Keep in mind that only the first picture box
created will be linked to the Image Controls.  This
means that only the first picture box created can
contain a captured image and that only this
picture box will be effected by the Zoom, Pan, or
Rotate features.  The other four picture boxes are
linked directly to the card format such as a line or
rectangle would be.  Please note that the original
images inserted into these picture boxes must be
saved somewhere on your system, otherwise they
will not be found when that particular format is
re-opened.

A picture box must be selected for it to be
modified or for an image to be inserted.  When a
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picture box is first created it is automatically
selected.  If you need to select a picture box which
is not selected, click anywhere within the box.
The color of a picture box can be changed by
selecting the Object Color option of the Change
menu.  

Click on this icon to select the Rectangle tool.  The
Rectangle tool allows you to place up to 100
rectangles into your card design.  To create a
rectangle, click on the Rectangle tool to select it.
Then, click somewhere within the card design area
of the screen.  A default rectangle size will appear
where you clicked.  

To move the rectangle, click and drag on its center.
To resize the rectangle, click and drag on one of
the handles.  Remember that a rectangle must be
selected in order to be modified.  When a
rectangle is first created, it is automatically
selected.  If you wish to modify a rectangle which
is not selected, you can select the rectangle by
clicking anywhere within the outline of the
rectangle.  

To change the color of a rectangleÕs outline, select
the Object Color option within the Change menu.
To change a rectangleÕs fill color, select the Fill
Color option within the Change menu.
Additional rectangles will always retain the color
properties of the previously placed rectangle.  The
size of new rectangles, however, will always
remain at the default setting.

Click on this icon to select the Text tool.  The text
tool allows you to place up to 100 text boxes into
your card design.  To create a text box, click on the
Text tool to select it.  Then, click somewhere
within the card design area of the screen.  A text
box containing the word ÒTextÓ and the number of
that particular text box will appear.  

To move the text box, click and drag on the center
of the box.  To resize the text box, click and drag
on one of the handles (changing the size of the

4-18 The Card Design Mode

510460 Fargo  8/5/98 11:35 AM  Page 4-18



text box does not change the font size).  To insert
your own text into the text box, select the Text
option from the Edit menu.  To link the text box to
a data field, select the Link Data Field option
from the Change menu.  Remember that a text
box must be selected before it can be linked or
edited.  When a text box is first created, it is
automatically selected.  If you wish to edit a text
box which is not selected, you can select the text
box by clicking on its center.  

To change the font, size, or color of text, refer to
the Fonts option within the Change menu.  To
change the alignment of text within a text box to
the left, center, or right, select one of the text
alignment icons from the tool bar.  Additional text
boxes will always retain the font, font size, and
font color properties of the previously placed text
box.

V.  CARD DESIGN SCREEN DATA ENTRY AND IMAGE
CONTROLS

When in the Card Design mode, the Data Entry Fields, the
Data Control box, the Video display window, and the
Camera Control box, all provide the same features and
functions as in the Data Entry mode.  Refer to Chapter 3,
sections IV, V, VI, and VII for more information about all of
these on-screen features. 
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Chapter 5: Using CardMaker

Now that you are familiar with both the Data Entry screen
and the Card Design screen, you are ready to begin using
CardMaker.  This chapter will guide you, step by step,
through the process of creating a new card format and using
that format as a template for entering all database
information.

I.  DESIGNING A CARD FORMAT

Although CardMaker allows you to create your own custom
card formats, it also provides several default card formats for
those who do not wish to create their own card designs.
These default card formats offer a variety of the most
common card designs and can be opened through
CardMakerÕs Data Entry screen.  If you do not wish to create
a new card format, open any one of these card formats and
refer to section II of this chapter.     

To create a new card format, you must first access the Card
Design screen.  This is done by selecting the Unlock Design
Access option from the File menu (see Chapter 3, section II-
A for more information on this option).  Once accessed, a
new, blank card outline and all of CardMakerÕs on-screen
design features will display.  To begin creating your own
card format, refer to the following steps:

1. The blank, outlined area in the design portion of the
screen illustrates the boundaries in which your card
design must be contained in order to be accurately
printed.  Anything which falls outside of these
boundaries will not show up on a printed card.  To
change the size or orientation of this outlined area, select
the Printer Setup option from the File menu and change
the settings accordingly.  To change the card format,
select the Card Layout option from the File menu.
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2. Use the Text tool described in Chapter 4, section IV to
create a text box.  Drag the text box to the desired area of
your on-screen card design.  Create up to 100 text boxes
as needed.  Hint:  You may wish to activate the design grid
by selecting the Grid Setup option from the Change menu.
This will make it much easier to align the various objects
within your card design.

3. If you wish to enter ÒfixedÓ text or text which will not
need to be changed through the Data Entry screen (such
as a company name), select the Text option from the Edit
menu.  Once you have entered the desired text, select the
OK button.  The text will then appear on your card
design and be saved along with the other design objects
into your card format.  

If you wish to enter ÒvariableÓ text or text which varies
with each database record (such as a personÕs name or
employee number), you must first link the selected text
box to a data field.  To do so, select the Link Data Field
option from the Change menu and specify the data field
to which you wish to link the text box.  The text box will
then be linked to the specified data field; therefore, any
text entered into that data field will also appear on your
card format.  Create and link as many text boxes as you
need to display your variable data.

To change the font, size, or color of your text, select the
Fonts options from within the Change menu.

4. Use the Picture Box tool described in Chapter 4, section
IV to create a picture box.  Drag and drop the picture box
to where you would like the captured image to appear
on your card design.  Remember that the first picture box
created is the only picture box which will be linked to the
Image Controls and which can contain a captured image.
Create up to four other picture boxes as needed for
inserting a logo, graphics file, or any other accepted
image file from another disk or application program.

5. Use the Line and Rectangle tools to create up to 100 lines
or 100 rectangles.  Use these objects to enhance and
further customize your card design.  Refer to Chapter 4,
section IV for information on changing line or rectangle
size, position, and color.
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6. Once your new card format is finished, select the Save
option from the File menu to save it as a specific card
format.  You may wish to print your new format before
continuing to assure that all objects are positioned and
sized to your satisfaction.  Remember, that no matter
how your card is laid out on screen, card objects will
always print in a preset order.  Refer to Chapter 4,
section II-B for information on CardMakerÕs Send To
Back option and its specific object print order.

7. Select the Lock Design Access option from the File
menu to exit the Card Design screen and to return to the
Data Entry screen.  Although you can just as easily
operate the image capture and database controls form
the Card Design screen, it is always best to operate these
controls with the design screen locked.  This assures that
you will not inadvertently change your card format.

Refer to section II for information on working with
CardMakerÕs Data Entry screen.

II.  WORKING WITH THE DATA ENTRY SCREEN

If you have just completed the steps in section I, your new
card format should still be displayed.  If you chose to skip
section I and to simply utilize one of the default card formats
provided with CardMaker, open a default card format at this
time.  In either case, you should now have a card format on
screen.  To begin capturing images and entering variable
database information, refer to the following steps:

1. Enter the personÕs name, ID number, and all other
variable data into the appropriate data entry fields.  Data
entered into linked data fields will also appear on your
card format.  Remember that you should always enter
some sort of a unique entry into the CardID: field (the
first data field), even if you have not linked this field to
your card format.  The CardID: field can contain up to
eight characters and serves to distinguish each individual
database record.  This makes it impossible for you to
accidentally save a duplicate record to your database.
Note that the database record cannot be saved unless you
have entered a unique entry into the CardID: field.

5-4 Using CardMaker

510460 Fargo  8/5/98 11:35 AM  Page 5-4



Select the Auto ID: check box in the upper left-hand
corner of the Data Entry Window if you would like to
have a sequential number automatically placed into this
field.

2. Once all variable information is entered, you can then
capture the personÕs image.  To capture an image,
position your subject in front of the camera with a solid,
lightly colored background or backdrop behind them.
For best capture results, be sure the camera is set up and
zoomed in so that a minimum amount of ÒdeadÓ space
appears above, below, and to the sides of your subject.
Properly arranging the camera and your subject before
capturing an image will minimize the amount of image
manipulation needed after the image is captured.  Such
preparation aids in reducing the amount of time needed
to create an ID badge and also helps maintain the best
overall image quality. 

To further enhance the quality of your captured image,
you should also utilize lighting which will remain
consistent throughout your badging session.  For
example, do not capture images in a room where the
amount of sunlight may vary throughout the day.  For
best results, you should capture images in a room with
no windows or in a room with the shades drawn so that
only florescent or incandescent lighting is apparent.  The
room should, however, be brightly lit.  

Most cameras can also be adjusted to accommodate
varying amounts of light.  You may have to configure
your camera according to your image capture
environment and experiment with different lighting to
achieve optimum capture results (refer to the appropriate
camera documentation for configuring your camera).
Use flashes only as directed by your specific camera or
system documentation.

Once your capture equipment is properly arranged and
your subjectÕs image is centered within, click on the
Video button from within the Image Control box to
capture the personÕs image if using the Video Vue board.
If using a TWAIN device, select the appropriate capture
option from the deviceÕs software interface.  After a few
seconds, the personÕs image will appear within the first
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picture box of your on-screen card format.  If needed, use
the Pan, Zoom, and Rotate controls within the Image
Control box to manipulate the captured image within the
picture box.  

3. After the captured image and all variable data are
entered or displayed,  select the Save button from the
Data Control box to save your new database record.  All
information contained in the record, including the
captured image, will then be saved.  Refer to Chapter 3,
section V for important information on the Save
command.

4. Select the Print option from the File menu or click on the
Print icon from CardMakerÕs Tool Bar to print your new
ID badge.  Be sure that the printer driver is properly set
up before printing.  Depending on the complexity of
your card design, your card format will take from just a
few seconds to a minute or so to begin printing.

5. If you have successfully saved and printed your new
card format and database record, congratulations!  You
are now familiar with the basic operating functions of
CardMaker.  To continue entering database records,
select the New button from the Data Control box.  A new,
blank set of data fields will display in the Data Entry
window.  Enter and save as many new database records
as you have room for on your hard disk.  Use the
controls within the Data Control box to navigate within
your database.  Remember to always save each new
database record as it is created.  Refer to Chapter 3,
section V for important information on the Save
command.
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Appendix A: Bar Code Fonts

A-2 Bar Code Fonts

If you need to incorporate bar codes into your ID card format
and would like them to be printed with the Color ID Card
PrinterÕs resin black ribbon panel, you must utilize a
TrueType bar code font.  For this reason, CardMaker ships
with a series of Code 39 TrueType bar code fonts.  These
fonts are automatically placed in the CardMaker directory
when CardMaker is first installed.  To install these fonts,
refer to the section I.

I.  INSTALLATION

1. Double-click on the Control Panel icon within the Main
program group.  This will open the Control Panel
window.

2. Double-click on the Fonts icon within the Control Panel
window.  This will open the Fonts dialog box.

3. Select the Add... button.  The Add Fonts dialog box
displays.

4. Select and open the Cardmakr directory from the
appropriate drive.  This will display all of the Code 39
fonts in the List of Fonts box.

5. Select the Select All button.

6. Once all fonts are highlighted, select OK to install the
fonts.  All selected fonts will be added to your
Windows\System directory and will be available to all
Windows applications.

7. Select the Close button to close the Fonts dialog box.
Font installation is now complete.
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II.  THE CODE 39 PACKAGE

The Code 39 package includes several fonts.  The following
table shows the attributes of each of these bar code fonts
when printed at a size of 18 points.  There is also an
additional set of fonts included in the Code 39 package that
contain an 8% bar width reduction.  The names of the bar
width reduced fonts end with the letters ÒRedAÓ.  These
fonts are for use in printing techniques such as flexography
where a significant amount of ink gain occurs.  They may
also be useful on other types of printers.  You may need to
perform a print test to see which font performs best for your
particular system.

Font Name Attributes (18 Points)

Code39One/Text Ratio: 3/1 X-width: .01Ó CPI: 6.25

Code39Two/Text Ratio: 3/1 X-width: .007Ó CPI: 9.38

Code39Three/Text Ratio: 3/1 X-width: .013Ó CPI: 4.6

Code39Four/Text Ratio: 3/1 X-width: .017Ó CPI: 3.75

Code39Five/Text Ratio: 2/1 X-width: .01Ó CPI: 7.69

Code39Six/Text Ratio: 2/1 X-width: .013Ó CPI: 5.76

Code39Seven/Text Ratio: 2.5/1 X-width: .01Ó CPI: 6.81

Code39Eight/Text Ratio: 2.5/1 X-width: .013Ó CPI: 5.08

The Code 39 TrueType bar code font set which ships with
CardMaker requires that a start and stop character be entered
at the beginning and end of the bar code data. This start and
stop character is the asterisk (*). An example of properly
entered bar code data is as follows: *123456*

NOTE: If you need to include a space character into your bar code, the
correct character to use is the exclamation point (!).  This character
contains the correct pattern for a bar code space.
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